
Function Reference
Grouped by menu, the functions of 3DSimED3 are documented in the following chapters.

File Menu
The File Menu includes functions for opening, and saving drawings in 3DSimED3 native format and for working with Material libraries.

Recent 
Documents

Opens a recently imported or opened model.

Open SimED 
Model

Open a model saved in 3DSimED3 native format.

Save SimED 
Model

Save a model in 3DSimED3 native format.

Import Model Open a model that is not in native format.

Import as Objects Import multiple models as object.

Import Options Options for importing some objects, these are for GPL, N4, NR2002/3.

Load Materials Open a saved material library.

Save Materials Save the materials in the present model as a library.

Recent Folder Set a recently used folder as the current working folder.

Open SimED Model
Opens a 3DSimED .3SE file for editing.

Save SimED Model
Saves a 3DSimED .3SE file to disk.

If any of the textures used by the Materials in the model are found to be in a relative path to the 3SE then you are prompted as ask whether relative 
paths of textures should be written rather than absolute paths. Relative paths are particularly useful when copying between machines or reading 
a .3SE over a network.

3SE files are native to SimED and are not read by any other applications.

File New
Simply creates a new blank scene. 

· A blank model can be useful as a temporary model when you are working with clipboard data which you are copying from one model to another. 

Recent File

Allows a recent model or scene to be opened.

File Import
Imports a model from many third-party formats. 

Some of the import formats use plugins and the status of these plugins can be checked using the function List Plugins

For nearly all formats the model import will either be composed of many objects or will be Editable Face Data

Below are some notes on the different formats 3DSimED3 imports.

.3ds Files|*.3ds|

Importing a 3DS file will result in a drawing with one or more objects.  To edit the individual object data you will need to isolate the objects in the 
Object Instance Edit Pane, or use Explode All .
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3DO/PTF Files|*.3do;*.ptf|

Importing most .3DO files just gives you the model data as faces. However, if you import a track .3DO then all the objects within that track are also 
imported.

A .PTF file contains references to TSOs which will be imported. 3DSimED also generates a mesh to represent the walls and track surfaces. Please 
note this mesh does not exist in the .PTF and is just a graphical representation of the PTF. SimED will not Import a PTF from the tracks supplied with 
the game N2003.

rFactor GMT files|*.gmt|

The .GMT files is imported so that the model data can be edited.

rFactor SCN files |*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to 
work with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

rFactor Veh files|*.veh|

Reads the complete definition of a vehicle and decompresses any .MAS files required. The GMT objects and textures are then read in. Importing a 
VEH file will probably cause SimED to create a temporary folder within the 3DSimED folder. If you need to save and work with the data you should 
use the Export Textures and Save Model functions on the File menu.

GTR GMT files|*.gmt|

A single GTR .GMT file is imported so that the model data can be edited.

F1-2001/2002 MTS files|*.mts|

The model data of a single F1CC/F1-2002/F1-2001 .MTS file is imported

F1-2001/2002 SCN files|*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to 
work with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

Nascar SimRacing MTS files|*.mts|

The model data of a single Nascar SimRacing .MTS file is imported.

Nascar SimRacing SCN files|*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to 
work with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

File Plugin Import

This function has been deprecated,  the importing of a Plugin type is now integrated into File Import.

Import Objects
This command allows you to import multiple models as Objects. Once opened you can edit the position, rotation etc of these objects

For most formats you will get one object for each file imported. Note that in the case of .3DS files these can have multiple objects.

File Import Options
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PSSG Only high level geometry. 
With this on the low level detail within objects will be skipped when importing.

DirectX .X Left Handed Coords. 
Most DirectX .X files use a left-handed coordinate system but it is possible for applications to export .X data with a right-handed coordinate system.

Obj Import swap YZ
Swaps the Y and Z axes when importing Wavefront .OBJ.

GPL:- Only high detail geometry
With this option on only the highest level of detail of GPL .3DO files will be imported, otherwise all levels of geometry will be imported.

GPL:- Double-sided materials
This option controls whether, when importing GPL .3DO files, the materials are set to double-sided or not.

Nascar N4...N2003:- Only high detail geometry
This option controls the level of detail imported from N2003 .3DO files. Switch off to import all levels of detail.

Nascar N4...N2003:- Include night geometry
Switch on if you want to import night geometry from N2003 .3DO files as well as day geometry.

Nascar N4...N2003:- .PTF longitudinal resolution
When a Nascar .PTF file is imported, the mesh generated for the track segments will have no face longer than this value, so a smaller value will give 
a smoother mesh.

Nascar N4...N2003:- .PTF Lateral resolution
When a Nascar .PTF file is imported, the mesh generated for the track segments will have no face wider than this value, so a smaller value will give a 
smoother mesh.

Nascar N4...N2003:- PTF Arc resolution.

When a Nascar .PTF file is imported the resolution of the mesh generated for corners is determined by this value. Use a small number for a smooth 
mesh.

File Load Material Library
Loads the selected material library. 

        Material Updating
Materials in the present drawing are 
updated if with those in the library, if they 
have the same name Hence, a Material 
Library can be built from a master drawing 
and re-used in other drawing.

.

File Save Material Library
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Saves the materials in the current drawing to disk

File Recent Folder
The sub-menu gives a list of the recently accessed folders. 

Select from this list to change the current working folder.

Texture Folders

This function allows the user to specify additional folders to search for texture maps when importing geometry.

· The folders defined in the list will be the last folders to be searched when looking for texture maps.

· In the example below a relative path is in the folder list. In this case this relative path will be added to the folder of the imported object or scene and 
the resulting folder will be searched for any missing texture maps. 

The dialog has four buttons in the header of the folder list.

New Folder Use this button to add a folder to the list. The path can be typed in directly or use the browse button (highlighted above).

Delete Entry Deletes a folder from the list (does NOT delete anything on the file system).

Move Entry Up Moves a folder up the list (will be searched before other folders in the list)

Move Entry 
Down

Moves a folder down the list (will be searched after other folders).

Axis Layout

This function sets the XYZ axis in 3DSimED3.

· Changing the Axis Layout will alter the output display in windows and panes throughout 3DSimED3, for example, the XYZ Coords of the Object 
Instance Pane.
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· The Axis Layout can be changed at any time, data will not be affected by changing the layout, it is simply the XYZ display in the user-interface 
which changes.

· Any data saved to disk is unaltered by the Axis Layout and can be opened, with no issues, by another user with a different layout.

Options

The Customize tab allows the use to customize the ribbon interface.

The Options tab contains the setting "Do not prompt when closing model" which controls warnings when closing a model or the program.

Home Menu
The Home Menu includes features from other menus grouped together as common functions required after starting 3DSimED3.

Expand
Many games, including racing simulators, pack objects and textures into archives using compression to save disk space.

The Expand functions read these archives and both decompress and unpack the individual files allowing editing.

Expand GTR   
Allows you to decompress a GTR file saving all the components archived within it. 

See Expand F1 .MAS for more information.

Expand rFactor .MAS
Allows you to decompress a rFactor .GMT  file saving all the components archived within it. 

See Expand F1 .MAS for more information.

Tools Expand Extract DDS
Extracts DDS files from GRID and DIRT .PSSG files. All DSS format textures found in the selected PSSG are written to the selected folder.

Tools Pack Update DDS in PSSG
Replaces the DDS files within a GRID or DIRT .PSSG file with the selected DDS files. If a selected DDS is not in the PSSG it is ignored.  If the DDS is 
not of the correct format there is a warning message and the DDS file is skipped.

Expand TOCA .BIG
Decompresses a TOCA .BIG file to the selected folder. Any .BIG files found within the parent are also decompressed to the chosen folder.

Expand F1 Mas
Expands a F1CC or F1-2002 .MAS file to a folder. The .MAS files are compressed archives of files used for tracks, cars , logos etc.

After selecting a .MAS file to expand the destination folder must be selected:-
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+

Note that, if more information about a folder is required, you can right-click on the folder name and you will be given a number of choices such as 
'Explore'.

Confirm the folder selection  with OK and you then be asked to confirm the selections you have made so far are OK. 

Finally there is a prompt asking whether to overwrite files of the same name already residing in the destination folder.

Expand Papyrus .DAT
Decompresses a Papyrus .DAT file to the selected folder.

Expand Nascar Heat/Viper Racing .RES
Extracts all files contained within an .RES resource archive.

ERP Archive Expand

There are two functions available to decompress ERP archives which have been used in the F1 games 2015 to 2017.

Single ERP Archive Expand

Prompts for a single ERP file and a destination folder. Note that the archived files have folder names so you will normally find that a single ERP may 
include files across a number of sub-folders.

Batch ERP Archive Expand

Prompts for a source folder and a destination folder. 

· This function will expand all ERP archives in the folder tree starting at the source folder. Note that the archived files have folder names so you will 
find many new folders will be created as sub-folders of the destination folder. 

· All the ERP archives in a game can be decompressed with this function but it will take a long time, however, this function starts a new thread within 
3DSimED3 so other functions can be used, there is no need to wait for the completion of the operation. 

· When finished there is a message box displayed giving the number of ERP found and files written to disk.

Edit Select All Visible
Selects all faces and objects presently displayed. This function uses the Display->Object Filter, Display->Material Filter and Display->Shader Filter 
settings to determine which faces and objects to select. For example, if the material filter is set to display only the material grass, all objects 
containing that material are selected. Note that geometry outside the present view will also be selected.

The sub-menus which follow are identical in both Edit Select All Visible and Multiple Selection (CTRL + left mouse button).

Selection Sub-Menu.

A sub-menu is presented offering the choice to modify the face data or the objects selected.

Face Sub-Menu
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Replace Materials will assign the chosen material to all faces in the selection.

Erase deletes all the faces in the selection.

Crop deletes all the faces outside the selection.

Copy replaces the faces on the internal clipboard with the selected faces.

Cut is equivalent to Copy followed by Erase.

Reverse Face reverses the direction the faces are pointing. After this operation one of the Edit->Normal functions should be used to correct the 
normals.

Vertices RGBA allows the RGB and vertex alpha to be set for the vertices within the selection.

Object Sub-Menu

Hide simply hides the objects.

Erase deletes the objects.

Copy replaces the objects on the internal clipboard with those selected.

Facet Normals recalculates the normals within the selected objects with facet normals.

Smooth Vertex Normals replaces all the normals within the selected objects with smoothed normals.

Up Normals replaces all the normals within the selected objects with normals that point up the z axis

Set Tags sets the attribute tags for the objects. See the Object Tag help for more details.

Split Objects by Material will create an object for each material of the objects selected. See Split Objects by Material.

Rename Objects allows renaming of the displayed objects Rename Objects/Materials.

Reverse Faces and Double Side will change the direction faces point, please see Object Instance Edit Pane.

Edit Object By Name

An Object can be selected by name. Objects are highlighted and become the view 
center when selected from the list.
Either double-clicking on an Object name, or the OK button, will give the Object 
Instance Edit Pane
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Tools Texture Browser
Allows you to browse textures.

· The file types recognised include .MIP, .M16, MI4 (from the Papyrus sims) as well as .BMP, TGA, DDS, PNG etc.

· If a texture has transparency this is shown as magenta if the Show Alpha=0 as magenta box is ticked.

· Note there are also options to allow conversion of single graphic files to other formats and a Batch Conversion tool.
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Load DX9 Shaders

Load DX9 Shader Programs
If there are problems opening new drawings then there is a possibility that the Shader programs which have to be loaded are the cause. Use this 
function to switch off the loading of Shaders. Please note this can have no effect until the next drawing is opened.

Export Menu
The Export Menu allows models to be exported to many different formats, including many of the recent popular sims as well as a number of formats 
for exchanging data with other 3D editors.

· The best way to save work in progress is to use the native save function, File Save SimED Model

A list of the export formats, by category, follows below.

ISI/SimBin Games GMotor2

Save As rFactor 2 Model

Save As rFactor 2 Objects

Update rFactor2 SCN

Save Race07 Model

Save Race07 Objects

Save Race Model

Save Race Objects
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Save rFactor Model

Save rFactor Objects

File Save GTL Model

Save GTL Objects

Save GTR2 Model

Save GTR2 Objects

Update SCN or TRK

ISI /SImBin Game GMotor

Save Mts Model

Save F1 Mts Objects

Save GTR Model

Save GTR Objects

Papyrus Games

Save N2003 Model

Save N2003 Objects

Save Model as GPL .3DO

Save Model as .ASE for GPL

Update .PTF Objects

Other Games

NFS Shift

Viper Racing

Nascar Heat

RBR

CAD/Design Formats

Collada DAE

SketchUp .SKP

3DSMax .3DS

Autocad .DXF

Microsoft .X

GPS Data
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Plugin Export
Exports a model using a 3DSMEX plugin which allows third parties to write code to export formats not included in 3DSimED3.

The export of Collada .DAE and SketchUp .SKP are now handled by plugins.

A list of the available plugins can be found using List Plugins

Plugin Export as Objects
Exports the objects within the present model as individual objects using a 3DSMEX plugin  which allows third parties to write code to export formats 
not included in 3DSimED3.

Saves Editable Face Data to the selected filename while the objects within the scene are automatically named.

A list of the available plugins can be found using List Plugins.

Save Model Data
Saves Editable Face Data to Automobilista .GMT format. Note that this data does not include the objects within the scene. To save them you will 
need to use Save Automobilista Objects

· Automobilista requires data to be encrypted, 3DSimED3 will call rfactordec.exe to encrypt the data. Rfactordec.exe is a third party tool which 
needs to be downloaded and be present either in the 3DSimED3 folder or in one of the folders listed in the PATH environment.

· Make sure the .GMT is written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps in .GMT do not include the path name so you will need to make sure your textures have been written to a folder in the search path list 
of the target track or vehicle. 

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimED3.

Save Objects
This function saves the objects within the model to Automobilista .GMT format.

A pathname browser dialog prompts for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

· Automobilista requires data to be encrypted, 3DSimED3 will call rfactordec.exe to encrypt the data. Rfactordec.exe is a third party tool which 
needs to be downloaded and be present either in the 3DSimED3 folder or in one of the folders listed in the PATH environment.

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

· A scene file, output..scn is written. This file contains entries for the .GMT instances saved and is to help with the editing of scene or vehicle files.

· Make sure the .GMT are written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps names in .GMT files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

Save Race 07 Model
Saves Editable Face Data to Race 07 .GMT format. Note that this data does not include the objects within the scene. To save them you will need to 
use Save Race 07 Objects

· Make sure the .GMT is written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps in .GMT do not include the path name so you will need to make sure your textures have been written to a folder in the search path list 
of the target track or vehicle. 

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimED3.

        Race 07 Folders Information
For the .GMTs to be read by Race 07 you will need to make sure you 
have a GameData\Locations\Track folder within your Race 07 folder, 
an example might be "\Program 
Files\Steam\SteamApps\MyUserName\race 07
\gamedata\locations\MyTrack"

Save Race 07 Objects

This function saves the objects within the model to RACE 07 .GMT format.

A pathname browser dialog prompts for the destination folder for the .GMT files.

Page 11 of 34Function Reference

2024-09-30file:///C:/Users/Matt/AppData/Local/Temp/~hh11AC.htm



There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

· A scene file, output..trk is written. This file contains entries for the .GMT instances saved and is to help with the editing of scene or vehicle files.

· Make sure the .GMT are written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps names in .GMT files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

        Race 07 Folders Information
For the .GMTs to be read by Race 07 you will need to make sure you 
have a GameData\Locations\Track folder within your Race 07 folder, 
an example might be "\Program 
Files\Steam\SteamApps\MyUserName\race 07
\gamedata\locations\MyTrack"

Save Race Model
Saves model data to RACE .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save 
Race Objects

Notes.

For the .GMT to be read by Race you will need to make sure you have a GameData\Locations\Track folder within your Race folder, an example might 
be

"\Program Files\Steam\SteamApps\MyUserName\race\gamedata\locations\MyTrack"

Make sure you save to this folder for Race to find the .GMT.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Race normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save Race Objects
This function saves the objects within the model to Race .GMT format.

A pathname browser dialog prompts for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

· A scene file, output..trk is written. This file contains entries for the .GMT instances saved and is to help with the editing of scene or vehicle files.

· Make sure the .GMT are written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps names in .GMT files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

.

        Race Folders Information
For the .GMTs to be read by Race you will need to make sure you have a 
GameData\Locations\Track folder within your Race folder, an example might 
be "\Program 
Files\Steam\SteamApps\MyUserName\race\gamedata\locations\MyTrack"

Save N2003 Model
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· Saves model data to N2003 .3DO format. Note that this data does not include the objects within the drawing. To save them you will need to use 
File::Save N2003 Objects

· If the model data did not come from N2003 you will need to convert textures to N2003 .mip files. You can do this from Tools::Texture Browser

Save Options

Visible All Week

Controls in which part of a race weekend the object will be displayed.
Race Weekend

Testing Only

Practice, Qualification

Race Only

Seen at all Distances: The object will be seen from far away.

Minimum Object: The object will be visible in N2003 when displaying only minimum objects.

Save N2003 Objects
Saves the objects within the model to N2003 .3DO format.

A dialog prompt for the destination path for the .3DOs.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Faces which are just solid colour are altered to use the texture named _rgbmap.mip  This is supplied with 3DSimEd.

If the model data did not come from N2003 you will need to convert textures to N2003 .mip files. You can do this from Tools::Texture Browser

Save F1 MTS Model
Saves Editable Face Data to F1CC/F1-2002 .MTS format. Note that this data does not include the objects within the scene. To save them you will 
need to use Save F1CC/F1-2002 Objects

Saves Editable Face Data to F1CC/F1-2002 .MTS format. Note that this data does not include the objects within the scene. To save them you will 
need to use Save F1CC/F1-2002 Objects

· Make sure the .MTS are written to a folder that is in the search path list of the target track or vehicle.

· F1CC/F1-2002 use textures in .TGA or .BMP format. If a texture has either of these extensions it's name remains unchanged otherwise the 
extension is altered to .BMP when saving. If you need to convert textures for use in F1CC/F1-2002 then you can do this from Tools::Texture 
Browser

· Texture Maps names in .MTS files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Save F1 MTS Objects
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This function saves the objects within the model to F1CC/F1-2002 .MTS format.

A pathname browser dialog prompts for the destination folder for the .MTS files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

· A scene file, output..scn is written. This file contains entries for the .MTS instances saved and is to help with the editing of scene or vehicle files.

· Make sure the .MTS are written to a folder that is in the search path list of the target track or vehicle.

· F1CC/F1-2002 use textures in .TGA or .BMP format. If a texture has either of these extensions it's name remains unchanged otherwise the 
extension is altered to .BMP when saving. If you need to convert textures for use in F1CC/F1-2002 then you can do this from Tools::Texture 
Browser

· Texture Maps names in .MTS files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Save rFactor Model
Saves Editable Face Data to rFactor .GMT format. Note that this data does not include the objects within the scene. To save them you will need to 
use Save rFactor Objects

· Make sure the .GMT is written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps in .GMT do not include the path name so you will need to make sure your textures have been written to a folder in the search path list 
of the target track or vehicle. 

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimED3.

Save rFactor Model, Add to .MAS

Saves rFactor Model, and then adds to .mas archive.

Adds the saved .GMT  to a selected .mas archive file. 

· This function is useful when editing of an object has been completed.

· While editing you do not need to do this as rFactor always reads .GMT from disk in preference to that packed in a .mas archive.

· The saved .GMT is not deleted.

Save rFactor Objects
This function saves the objects within the model to rFactor .GMT format.

A pathname browser dialog prompts for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

· Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

· A scene file, output..scn is written. This file contains entries for the .GMT instances saved and is to help with the editing of scene or vehicle files.

· Make sure the .GMT are written to a folder that is in the search path list of the target track or vehicle.

· Texture Maps names in .GMT files do not include the path name so you will need to make sure your textures have been written to a folder in the 
search path list of the target track or vehicle. 

Save rFactor Objects, Add to .MAS

Saves rFactor Model, and then adds to .mas archive.

Adds the saved .GMT  to a selected .mas archive file. 

· This function is useful when editing of an object has been completed.

· While editing you do not need to do this as rFactor always reads .GMT from disk in preference to that packed in a .mas archive.

· The saved .GMT is not deleted.

Export rF2 ANM
Exports character Animation sequences to rF2 format .ANM files.

· The function will only be enabled if animation is present in the model.
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· As animations cannot be edited within 3DSimED3, this function is provided to save animations that have been imported, if an existing animation is 
required by another track or car it is safer to simply copy the files by hand.

Primitives Menu
The Primitives Menu allows simple objects to be created.

Primitives New Upright
Adds a new Upright to the drawing data. An Upright is a standing rectangle.

Enter the position and dimensions of the Upright in the dialog. Before the Upright is added to the drawing the Group Edit Pane which will allow you to 
transform the faces as if they are in an object. 

Primitives New Rectangle
Adds a new rectangle to the drawing data.

Enter the position and dimensions of the rectangle in the dialog. 

Before the rectangle is added to the drawing, the Group Edit Pane will be presented which will the faces to be transformed as if they are in an object. 

Primitives New Box

Adds a new Box to the drawing data.

· Enter the position and dimensions of the Box in the dialog. 

· The Use Extents will take the extents of the Editable Face Data and create a bounding box.

· Before the Box is added to the drawing, the Group Edit Pane will be presented which will the faces to be transformed as if they are in an object. 

Primitives New Sphere
Adds a new Sphere to the drawing data.

Enter the position and dimensions of the Sphere in the dialog.

Before the sphere is added to the drawing, the Group Edit Pane will be presented which will the faces to be transformed as if they are in an object. 

Primitives New Cylinder
Adds a new Cylinder to the drawing data.

Enter the position and dimensions of the Cylinder in the dialog. 

Before the cylnder is added to the drawing, the Group Edit Pane will be presented which will the faces to be transformed as if they are in an object. 

Primitives Add Object
Use this function to add objects on disk. You can add objects from a wide range of sims or SimED's native 3SE format. Once the object has been 
selected you will be presented with the Object Instance Edit Pane.
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Edit Menu
The Edit Menu has a large number of functions which allow a model to be edited. 

· 3DSimED3 features a full undo stack to allow stepping back through edit steps.

·  If a function is disabled it will be because editable data is not present.

Edit Previous Face
Re-selects the last face selected for editing.

Edit Previous Object
Re-selects the last object selected for editing.

Edit Resize
Resizes the faces/polygons of the model data (but not the objects in model).

Edit Translate Model
Translates the model data and object positions by the XYZ entered in the dialog.

Edit Rotate Model
Rotates the Editable Face Data by the angles entered in the dialog. The rotation of objects remains unchanged.

Edit Mirror Model
Mirrors the model data about the chosen axes. Note that you may need to re-work the texture coordinates after a mirror. To do this use the Material 
Editor Re-scale Texture coordinates function.

Edit Centre Model
This groups of functions are for editing the center/pivot point of Editable Face Data.

Geometric Center Model
Finds the geometric center of the Editable Face Data and places it at 0,0,0 and updates the model Pivot Point with the center.
Note that when exporting to ISI formats such as rFactor the option to add back the Pivot Point will have to be selected otherwise the model will be 
saved with incorrect vertices.

Pivot Center Model
Places the Pivot Point of the Editable Face Data at 0,0,0.
Note that when exporting to ISI formats such as rFactor the option to add back the Pivot Point will have to be selected otherwise the model will be 
saved with incorrect vertices.

Bottom Center Model
Places the bottom center of the Editable Face Data at 0,0,0 and updates the model Pivot Point.
Note that when exporting to ISI formats such as rFactor the option to add back the Pivot Point will have to be selected otherwise the model will be 
saved with incorrect vertices.

Set Pivot Point
Sets the Pivot Point of the model.

Edit Object Centrers
The functions below give the user various ways of centering objects or moving the pivot points to the object centers, making it easier to scale and 
rotate objects in Object Instance Edit Pane. 

Unless the format you are exported to requires centered objects you should use the pivot point functions as they do not touch the object vertices at 
all.

Center Objects Pivots
Moves each Object Pivot Point to the geometric center of each object.

Bottom Center Objects Pivots
Moves each Object Pivot Point to the geometric bottom center of each object. Bottom Centered Pivot Points are useful with trackside objects.

Geometric Center Objects
Calculates the geometric center of objects and re-centers the objects so that they have a local origin at this center. The prompt "Use Pivot Points if 
set?" is asking if pivot points should be used for the objects they have been set for, it is recommended that defined Pivot Points are used for the 
center of objects.

Bottom Center Objects
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Calculates the bottom center of objects and re-centers the objects so that they have a local origin at this center. The prompt "Use Pivot Points if set?" 
is asking if pivot points should be used for the objects they have been set for, it is recommended that defined Pivot Points are used for the center of 
objects.

Bottom centering will place the pivot point at the bottom of the object which is very useful for trackside objects.

Edit Normals
Each vertex of a 3DSimED3 model has a normal, and the functions below allow these normals to be calculated in different ways.

Facet Normals
Every vertex of every face is given a normal and that normal is determined by the face normal. This causes every edge in the model to be hard.

Smooth By Group
Smoothing groups are used to calculate the normals.  If faces share a smoothing group then the edges between them will be smooth, otherwise the 
edge will be hard.

Models imported from .3DS, .GMT and Wavefront .OBJ have smoothing groups.

Smooth All
Vertexes shared by faces also have shared normals so every  shared edge in the model should appear smooth.

Auto Smooth
For an edge to be smooth the angle between two faces must be less than the smoothing angle otherwise the edge will be hard.

Up Normals
Replaces calculated normals with normals that point up the z axis. This is useful for 'far-away' objects such as rows of trees and all edges will be 
smooth.

Edit Materials

· The Materials list is filtered by the settings of Material Filter and Shader Filter.

Highlight Shows the selected material in the drawing.

Edit From the list of materials select one and use the Edit button to 
display the Material Edit Pane,.

New To create a new material, based on an existing material, 
select a material before clicking the New button, theMaterial 
Edit Pane will open to edit the new material.

Rescale Invokes Re-Scale Texture allowing modification of the primary 
texture coordinates for the selected material. 

· The Material Edit Pane gives control over other texture 
channels.

       Productivity Tip
A quick way to get in to the Material Edit 
Pane is to right click on any face and then 
select the material name from the Context 
Editing

Edit Replace Material
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· Select the material which is to be replaced. The 'Select geometry with no material' allows geometry which has no material to be assigned a material.

· This function replaces materials in objects as well as face data.

· The Materials list is filtered by the settings of Material Filter and Shader Filter.

Edit Erase Material Geometry

This function allows you do delete all geometry assigned to a material including those in objects. The dialog allows for multiple selection of materials.

· The Materials list is filtered by the settings of Material Filter and Shader Filter.

· The 'Select geometry with no material' button will delete geometry which has no material assigned.

· After using this function you may want to purge the material from the material list see Edit->Purge Unused Materials.

Batch Edit

Materials Batch Edit allows multiple materials to be edited at once.
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· The Material List at the top of the pane shows which Materials will be 
edited. This list uses the materials set by Display::Materialfilter.

· The Check boxes select which Materials from the list will be updated by 
future changes to values.

· Values in bold text will be batch updated, click in the blank box to set those 
values.

· Editing is 'live', you will see the drawing updated instantly (there is no 
apply button). 

· Most the View Menu and Display Menu functions are available; commands 
such as zoom, change view center, display model in wire-frame etc. can 
be used while editing .

· When editing is complete, close the pane using the confirmation tick 
button or exit button at the top right., in both cases changes will be kept. 

Toolbar

Cancel: Cancels editing, discarding any modifications to any materials and 
closes the pane.

Undo: Undo all changes to materials since the batch edit was started.

Paste 
Material:

Paste the material properties from the internal clipboard. 

Only the chosen groups of values will be updated - by default no 
values will be changed.

Show 
Material:

Highlights the selected materials.

Close: Closes the Edit Face Pane keeping all edits (this is the same result 
as using the close window button at the top-right of the pane).

Edit Material Set Shader
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· Set Shader allows the shader to be set for one or more materials.

· The Materials are filtered by the settings of Material Filter and Shader Filter.

· Select the Materials you want to edit and the OK button will take you to the Shader selection dialog.

Edit Copy All
Copies all the data within a drawing to an internal clipboard. Note this data is not available to other applications.

Edit Paste Objects
Pastes objects from the internal clipboard to the present drawing as objects with the same position, rotation and scaling.

Edit Paste Explode
Pastes objects from the internal clipboard to the present drawing but 'explodes' the data to Editable Face Data. This allows multiple objects to be 
combined to one single object.

Edit Paste Faces
Pastes faces from the internal clipboard to the present model, using the Group Edit Pane to transform the pasted data.
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The Group Edit Pane is for transforming a group of faces as if an object. There is also an option to create an object from the group. 

· Editing is 'live', you will see the drawing updated instantly (there is no apply button). 

· When editing is complete, close the pane using the confirmation tick button or exit button at 
the top right., in both cases changes will be kept. 

· Most the View Menu and Display Menu functions are available; commands such as zoom, 
change view center, display model in wire-frame etc. can be used while editing .

· The Toolbar includes an Undo button to allow you to cancel editing since the pane was 
activated. If only some of the editing needs an undo use the Edit Undo function.

Toolbar
The Group Edit Pane toolbar has a number of simple functions to apply to the group

Create Object: The group becomes an object, if this button is 'checked', otherwise the 
group data will become Editable Face Data.

· The pane will now become very similar to the Object Instance Edit 
Pane, follow the link for documentation.

Cancel: Cancels editing, discarding any modifications to the selected data and 
closes the Pane.

Undo: Reverts the group to its original transformation.

Copy: Copies the group to the clipboard as an object so that it can be pasted to 
other drawings.

MR: Overwrites the current XYZ coordinate with data from the memorized 
point. 

· A point can be remembered with the MS button or right clicking on the 
drawing and choosing Memorize XYZ

MS: Remembers a point.

Show edit: Highlights the current object.

Center view: Centers the view on the current object.

Close: Closes the Object Instance Edit Pane keeping all edits (this is the same 
result as using the close window button at the top-right of the pane).

Paste Materials
Pastes only the materials that were previously copied to the clipboard. Clipboard materials overwrite those in the drawing.

Edit Paste Vertices
Pastes vertices from the internal clipboard to the local model data.  If the number of vertices on the clipboard is different from that of the local data 
then the number pasted will be the smallest of the two counts.

Use the option dialog to choose which attributes of the vertices should be replaced with those from the clipboard. In the above example the UV 
channels 2 and 3 are not pasted and note that the texture coordinates of channels 0 and 1 will only be pasted if defined in the clipboard data; 
otherwise they will be ignored.

This function is particulary useful when working, for example, with NFS Shift damage .meb files. By using Edit->Copy All and Edit->Paste Vertices to 
the corresponding model that has no damage the damage can be revealed.
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Explode All
Explodes all objects to Editable Face Data. Objects within objects are also exploded until there are no objects and all data has become face data.

Face Data Attributes
Allows the Editable Face Data attributes to be edited.

See the Tag Attributes of the Object Instance Edit Pane.

Purge Unused Objects
Removes all unused objects from memory.

Purge Unused Materials
Removes all materials not  used in the drawing.

Purge Duplicate Points
Purge Duplicate Points

Removes duplicated points to minimize the storage required for the geometry.

Note that identical points in different objects are not purged only duplicates within the same object.

Purge Emptry Triangles
Purge Empty Triangles

Removes triangles which have two identical vertices.  These triangles can cause problems for functions such as Smooth Vertex Normals.

Edit Undo
Edit undo restores the model to its state before the last edit action. It should be possible to undo all actions on the model and Edit Redo is provided to 
correct stepping back too far 

· Note that the Undo stack can grow large and that may impact on 3DSimED3 performance, the Clear Undo Stack function is provided to free this 
memory.
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Edit Redo

Edit Redo will undo the last Edit Undo but is only available if no editing has occurred since the last Undo.

Clear Undo Stack

The memory requirements for a full undo stack can be very large and could cause 3DSimED3 to slow 
the system.
If the Undo Stack is cleared all undo information will be lost so, a warning message will show the 
present memory used by the Undo Stack, before the user chooses whether to clear the stack.

View Menu
As it name suggests, the View Menu allows the view of the model to be controlled.

View  Elevation

Plan Elevation
The view from above the scene (EW 0 NS 90).

Front Elevation
The view from the front of the scene (EW 0 NS 0)

Back Elevation
The view from the back of the scene (EW 180, NS 0)

Right Elevation
The view from the right of the scene (EW 90, NS 0)

Left Elevation
The view from the left of the scene (EW -90, NS 0)

Bottom Elevation
The view from underneath the scene (EW 0, NS -90)

View XYZ & Angles
A dialog is presented which allows the view to be set manually.

This is the dialog when working with a GPL track or N2003 .PTF. With other models you will get a simpler dialog without the Longitude, Latitude, and 
Elevation.

The Paste Pos takes clipboard text from the Memory Store function of other dialogs to set the position of the view centre. You can also copy text from 
the LLE Text field of a TrkMaker Material table and use the Paste Pos button to set the view centre.

View Reset View
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Resets the view centre to 0,0,0 and angles to EW 30 degrees NS 30 degrees. The zoom is set according to the extents of the scene.

View Eye Viewing
This command toggles Eye Viewing.

In Eye Viewing the camera is placed at the view centre and double-clicking the mouse will define a new position for the camera. The arrow keys will 
move the camera left, right, forward and backwards. Use the A amd Z keys to move the camera up and down.

To return to the usual view with the camera looking at the view centre just select Eye Viewing again.

View Walk Viewing.
This command toggles Walk Viewing.

With walk viewing the camera will walk the track. The forward and back arrow keys take you along the track while the left and right keys move you 
across the track. Use the A and Z keys to move the camera up and down.

To return to the usual view with the camera looking at the view centre just select Walk Viewing again.

        Key Information
This function is only available if you have 
opened a N2003 .PTF (with a RACE.LP in 
the same folder) or a rFactor/GTR/GTL/F1-
2002/F1-CC .SCN file with a .AIW file in the 
same folder.

View Object
The dialog lists all objects presently displayed in the model .

When an object is chosen from the list, the view changes and the object is highlighted in cyan.

The object selected will be the new view centre. Either choose from the list and select OK or double-click.

Display Menu
The Display Menu allows control over rendering of a model.

Display Wireframe
Simply displays a wireframe view of the model.

Display Flat Faces
Displays faces filled with colour without textures.

Display Textures
Model is displayed with faces rendered with textures. Faces with no textures assigned, or with the texture missing are rendered as flat shaded in 
colour.

Display Shadows
Switches on the display of shadows, see also Display DirectX 9 Options.

Night Lighting

Display Night Lighting
Switches on or off the use of night lights which can be used to light the drawing when the global light is beneath the horizon.

Show Lights 
Reveals the position of night lights by showing the night lights as bright circles of light 

Display XYZ Axis
Toggles the display of the XYZ axis.

Reflections
Toggles the display of reflected objects.
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· At present only the Reflected Environment objects of  rF2 are supported.

· The reflected objects are those listed in the rF2 .SCN file section ReflectionMapper=REFLECTEDENV.

· These objects are reflected by materials rendered by a small number of  rF2 shaders which include a reflection map as a source texture. 

· Commonly used shaders are the rF2 'road' and 'water' shaders. 

· To see the road reflections you will have to set the  rF2 road material parameter 'Rain' to a high value in the Material Edit Pane.

· Switching off reflections will replace the reflection map with a solid blue.

Sky Dome
Controls the display of a background Sky Dome. If switched off then a solid background colour is used set by Display Background Colour.

· Note that the Sky Dome requires Shader Rendering to be on.

Display Show Animations
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The check-box will toggle the display of object and material animations, and the slider will control the maximum frequency of the animation.

· Switching the animations off may help with editing because animations require continuous refresh of the display. 

· The frequency slider controls the maximum frequency of the animations, and the speed of any quicker animations will be limited to this maximum.

Display Object Filter

A list of the model objects is presented to the user. Select which objects you wish to display.

The Select By Tag options are useful when editing an ISI format model that has been imported as a scene or  vehicle.

Switch Off if NOT allows objects to be hidden which do not match the selected tag.

Note this function also changes which objects can be selected with the mouse right button and Edit->Select All Displayed..

Display Un-Hide
Switches on the display of the last object or material hidden with the right button menu.

Display Material Filter
A list of the materials present in the model is presented to the user. Select which materials you wish to display.

Note this function also changes which faces and objects can be selected with the mouse right button.

Display Shader Filter
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· The Shader Filter allows the user to filter the display of the model by shader.

· The Shader Filter is applied after the Material Filter has been set. For geometry to be displayed both the material and the shader for that material 
must be set to on.

· This function will change which faces and geometry can be selected by the mouse and the Edit->All Visible function.

Display Culling
Allows you to switch off faces depending on whether they are front or back-facing.

Most games will only render front-facing geometry, so effectively the geometry is one-sided. However, 3DSimED3 defaults to displaying both front-
facing and back-facing geometry this is to make it as easy as possible to select data for editing.

Culling removes either back-facing or front-facing geometry from rendering, this can help in showing data which is facing in the wrong direction, and 
also to see a model as a game would.

Back Face Culling
Switches off the rendering of back-facing geometry. If you are looking at the front of an object and this culling hides your geometry then you need to 
reverse the way the faces are pointing (see Edit Face Pane) or, if the data is an object then use the Object Instance Edit Pane.

Note this is also useful as a filter when editing data. All back facing faces are not selectable with this switched-on.

Front Face
Switches off the rendering of front-facing faces, hence you should see no front facing faces when looking at the front of your geometry. If you see 
faces which should be back facing these need reversing (see Edit Face Pane) or, if the data is an object then use the Object Instance Edit Pane.

Note this is also useful as a filter when editing data. All front facing faces are not selectable with this switched-on.

Display Reload Textures
Reloads all textures in the model. Use this function to see textures you have modified since the model was opened.

Display Colours and Fog
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Colours

This dialog allows the background, diffuse light, and ambient light colours to be changed.

Clicking on the colour boxes for Background, Diffuse Light and Ambient Light, will give the standard Windows Colour Common Dialog allowing 
customs colours to be assigned.

There are also four colour presets to choose from. Note that the Default button will restore the background colour as well as the diffuse & ambient 
light colours while the other three presets will only change the diffuse & ambient light colours.

Display Sky No Z Depth
Renders sky objects behind all the other objects in the scene, which can be particularly useful when using Eye or Walk Viewing.

· For this to work materials in the sky object must be marked as 'No Clip' and the sky object should be the first object to be drawn in the scene. When 
importing from rFactor, GTL, GTR2, Race and Race 07 3DSimED will order objects to make sure the sky is drawn first and you should find that the 
materials have been tagged as 'No Clip'.

· If an object needs to be forced to be the first drawn then use Object Instance Edit Pane  to make the object 'First'.

Display HDR

HDR Render

Renders using HDR lighting calculations. 

Settings 

The HDR Edit Pane allows the HDR variables to be edited.

Toolbar

Render: Render the current scene with HDR, this button will be disabled 
if the video card does not have the required hardware support.

Copy: Copies the values to the clipboard as text ready to paste to a 
rF2 HDP file.

Paste: Reads text on the clipboard and overwrites any values found 
(the text must be in the same format as that in rF2 HDP files.

HDR Values

Time of day: The time associated with these values using a 24-hour clock 
HHMM. 

White Point: This controls the final brightness, higher values cause a dimmer 
scene with reduced contrast.

Black Point: Lowers the brightness of all pixels and any with brightness 
below the black point value become black (so it increases the 
number of black pixels in the rendered scene).

Middle Gray: Another way of controlling the overall brightness - also known 
as the auto-exposure value.

Gamma: Controls the gamma correction, high values will give a washed-
out appearance.

Sky T. Lum: The diffuse brightness factor. Higher values will give the scene 
higher dynamic range.

Sky S. Lum: The ambient luminance factor. Higher values will lower the 
contrast between ambient and diffuse lit geometry.

Air Mass: This controls overall contrast lowering it and applying a hue-
shift towards yellow as it grows.
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Bloom

Use Bloom: Switches bloom rendering on and off.

Bloom 
Threshold:

The  cut-off for the brightness which will glow.

Bloom Offset: The magnitude of the glow effect.

Display DirectX 9 Options

Load DX9 Shader Programs
If there are problems opening new drawings then there is a possibility that the Shader programs which have to be loaded are the cause. Use this 
function to switch off the loading of Shaders. Please note this can have no effect until the next drawing is opened.

DX9 Shader Rendering
Should 3DSimED3 have stability problems, or the video card does not have good DX9 support, then switching off DX9 rendering may give improved 
rendering speeds and/or stability.

Software Shadows
These shadows are a little slower to draw but if they are problems with hardware shadows it may a better choice

Hardware Shadows
Faster than software shadows but not all DirectX 9 video cards support hardware shadows.

No XYZ Feedback
This switches off XYZ output to the status bar, if mouse movements are slow or moving the mouse causes instability it might be worth switching off 
XYZ feedback.

Software Mouse XYZ
The mouse XYZ is calculated will be much slower than hardware XYZ but not all video cards have the hardware support necessary.

Hardware Mouse XYZ
The XYZ position on the status bar is calculated with hardware support. 

Live Frame Buffer
Rendering a frame buffer for use with TV screens etc. is expensive in terms of memory and will slow down rendering. If you are using Materials with 
frame buffer output (see <%TARGETITLE%> and 3DSimED3 has become too slow try switching off the live frame buffer.

Tools Menu
The Tools Menu includes a variety of useful functions which fall outside the other menu groups.

Expand
Many games, including racing simulators, pack objects and textures into archives using compression to save disk space.

The Expand functions read these archives and both decompress and unpack the individual files allowing editing.

Tools Pack to rFactor
Tools Pack Files, rFactor .MAS, GTL .GTL, GTR .GTR

This function allows files to packed to various formats saving disk space.

The convention is to have two packed files, one containing all the objects and the other contained all the textures. For example, for rFactor you would 
pack all the .gmt objects to MyTrack.MAS and all the graphic files to MyTrackMap.MAS. You must make sure your scene file references these packed 
files.

Note that 3DSimED does not delete files from disk, or in the pack, when packing and that the operation always adds the files you select to the packed 
file. If a file already exists in the pack then it will be replaced.

Texture Map Conversion
This function allows all texture maps in the current model to be converted to another texture format. The user is prompted for the path and the type of 
texture map to convert to.

When the conversion is completed all the materials in the model will refer to the converted texture maps.

The Remove GUID suffix option is for texture maps such as those from Forza Apex which are appended with long GUID strings which are not not 
required in the converted texture map name.
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Texture Replace from Folder

These two functions simplify the task of either replacing existing textures with those from another folder, or finding missing textures.

Replace Missing and Loaded Textures.

This function is useful for tasks such as replacing a car livery with textures from another folder.

· The user selects a folder which will be searched for textures. 

· If the texture map title matches one of those already loaded in the present scene then it will replace the texture.

· Should a texture map match the title of a missing texture then it will be loaded and used in the scene.

Replace Missing Textures only.

This function is useful when looking for texture maps missing from the present scene as it will not replace any texture maps already loaded.

· The user selects a folder which will be searched for textures. 

· Should a texture map match the title of a missing texture then it will be loaded and used in the scene.

Direct Conversion From rFactor
The direct convert functions allow .GMT files in rFactor format to be directly converted to other similar .GMT formats suitable for GTL, GTR2, Race 
07, and rFactor2. This can be useful for those who have originated rFactor models in 3DSMax and exported them using the GMT plugin. The 
advantage of these functions is that attributes such as normals, numbers of triangles etc are left untouched. The disadvantage is that material names 
may need to be altered; to allow for this, a material mapping function is provided.

Direct Convert .GMT files, To GTL, GTR2, Race 07 or rFactor2
The user is prompted for the rFactor files to be converted and then a destination folder for the converted .GMT files. The .GMT files selected are 
directly converted to the chosen format.

Material Mapping GTL/GTR2/Race 07
This dialog allows the user to change the mapping of material names for Direct Conversions.

The left-hand names are the rFactor material name prefixes and the right-hand names are the new prefixes in GTL, GTR2 or Race 07. For example, 
using the table below a material named ovalrdpit in rFactor will be named concpit after the direct conversion. These material names are particularly 
important for track materials, and while 3DSimED's default mapping should work it's definitely worth spending some time looking at the material 
naming for the different sims.
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Material Mapping rFactor2

Save functionality as Material Mapping GTL/GTR2/Race 07, above, but a separate mapping setting is saved.

Split Objects by Material
This function is useful for preparing models for sims such as Netkar Pro. 

· Each object is split in to a number of objects - one for each material within the object.

· The names of the new objects suffix the original name with the material name and the index of the material within the object. 
For example an object named track01 might be split to track01_grass01, track01_roada02, track01_roadb_03, track01_cmwla04.

· An object which has only one material will not be split.

· At completion a message is displayed giving the number of new objects.

Rename Objects/Materials
This dialog allows batch changing of either Object or Material names.
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· Click in the new name column to edit a single object or material name.

· The Rename Dialog allows filtering of the displayed names. 

· Only the displayed filtered names can be changed.

· For a batch change set the text and then use the Do Batch Replace button.

· The tick boxes control the changes and the prefix & suffix text are added after the replace.

· You can review the changes before confirming, below you can see the result from the dialog above.

Tools Reports
Various useful reports on the present model are sent to a notepad-like dialog. This dialog allows simple editing and the ability to save a report to disk.

Model Info Gives a summary of the number of faces and vertices in the model as well as information on every object used in a model.

Missing Textures 
and Objects

A list of missing texture maps, objects and shaders; very useful for diagnosing problems with a model loading in a game.
Please note that the list of missing shaders is from the current session of rFactor so it will be all the missing shaders all the 
models opened since start-up.
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Textures and 
Object Used

A list, with the full path names, of all objects and textures in the model.

Object XYZ The position of every object instance in the model.

Materials Detailed information on every material in the model.

List Plugins
Lists the Import and Export Plugins found by rFactor at start-up.

Plugins must be placed in the same folder as rFactor. The import plugins have the extension 3dsmIM and the export plugins use the 3dsmEx 
extension.

Activation
3DSimED requires activation if it is to be used for longer than 20 days.

The Activation dialog gives the user a way to request and enter an activation code.

1) Request an activation code by clicking the Request activation code button.

2) A form will be presented asking for details about the original order, and should look something like the page shown here.
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3) When all the required details have been entered, hit the request Activation code button and a request will be sent for processing.

4) You may have to wait 24 hours for the code which will be delivered by email

5) The code you receive needs to be entered into the Activation code edit box (the green one) and then 3DSimED should be activated with the 
Activate! button.

Any problems try the help page at sim-garage here.
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